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Purpose of this Tool Kit

 This tool kit is designed to help funders who are interested in funding self-
advocates and self-advocacy organizations to have a better understanding of 
how to work best with people with disabilities, and make sure their needs are met 
throughout the grant process. This toolkit is the result of needs that were identified 
by the Association of University Centers on Disabilities (AUCD) while providing 
technical assistance for a self-advocacy pilot grant project that was funded by the 
Administration on Intellectual and Developmental Disabilities (AIDD).

Background

 In 2011-2012, AIDD funded self-advocacy summits and leadership gatherings of 
self-advocates and their partners to collect information around self-advocacy activities 
and policies in each of the 56 U.S. states and territories. The goal of these summits was 
“to learn what each state was doing around self-advocacy, help each state develop 
and present a state plan to strengthen their activities around this area, and develop 
national policy recommendations for AIDD and its partnering organizations” (Summits, 
2013). During these summits, the top theme identified by self-advocates and their 
partners was a need to provide support to strengthen self-advocacy and empower 
self-advocacy organizations. As a result, AIDD funded a series of pilot grants, managed 
by AUCD, in order to address these needs. 

 During the self-advocacy pilot grant projects, a number of recommendations 
were identified by the Association of University Centers on Disabilities (AUCD), who 
managed the contracting process provided technical assistance to the self-advocate 
grantees. These are some of the highlighted recommendations from that experience 
that may be useful for future Funders:

• Accessibility in grant-making is a topic with very scarce resources; AUCD is 
pleased to develop this toolkit and make resources available for future use.

• The lessons learned from this first effort represent initial development of 
a body of knowledge which identifies and refines successful strategies for 
supporting self-advocacy groups to become independent. 

• Adding to this small number of currently funded organizations will amplify 
the effort to empower self-advocacy organizations and will be more likely 
to have a national impact on self-advocacy organizations desiring increased 
independence and demonstrate a continued level of support to the self-
advocacy community. 



Key Concepts

 Self-advocates are people with disabilities who are advocating for themselves 
and others. Because there is a broad spectrum of disabilities, an individual’s needs 
for accommodation and support may also be very wide in scope. When working 
with self-advocates, it is important to take the time necessary to understand what 
accommodations are needed.  Requests for reasonable accommodations should be 
honored. Some examples of reasonable accommodations may include:

• A person with an intellectual disability may need a more easily understood 
version of a contract or require the contract to be explained. 

• A person with a sight-related disability may require that a document be provided 
in braille. 

• Some self-advocacy groups may need to request a time extension on a deadline 
in order to have enough time to fully understand the requirements for an 
application.

 Another important element about working with self-advocacy organizations is 
to include people with disabilities in every step of the process. This includes the initial 
development of ideas, the application review process, monitoring of grant activity, 
and the final reporting procedures.

 Many funders may not understand the importance of including people 
with disabilities at all levels of the grant process. Because self-advocates are often 
marginalized and face discrimination because of their disability, it is critical that 
groups working with self-advocates make a proactive, conscious effort to guide 
decision-making by the disability rights mantra, which states:

“Nothing About Us, Without Us”

 Not including self-advocates in your grant process may send a message of 
distrust to the organizations you are seeking to empower, and cause self-advocates 
to feel that their voice and viewpoints are not valued. Therefore, it is critical to include 
self-advocates as equal members of your grant development team, from start to 
finish.



Lessons Learned

 During its involvement with the Allies in Self-Advocacy pilot grants, AUCD 
requested feedback from all involved parties. It is imperative that we learn what 
worked and what didn’t, and share these lessons with organizations who support 
self-advocacy groups to support future funding opportunities for self-advocacy 
organizations. Outlined below are lessons learned in each phase; these are presented 
in bullet-point format so they can be easily identified in the report and taken into 
consideration for replication.

Developing the Request for Applications

1. Use language that is easy to understand  and support printed language with 
appropriate pictures and clip art

2. Color-code each grant opportunity. In the case of the pilot grants noted above, 
two grant opportunities were made available, and were referenced as Group A and 
Group B. All reference to Group A grants were in orange, and all reference to Group 
B grants were in blue.

3. Informational calls for applicants should provide detail in multiple formats, such as 
conference calls, online meeting rooms for visual support, and closed captioning.

4. Be present and available daily to respond to questions regarding the Request for 
Applications outside of the informational call.

5. Provide adequate time for organizations to develop the applications. 
6. nclude templates for each section of the application in the Request for 

Applications as appendices (Ex: templates for the application cover page, narrative 
with required sections, and budget).

7. Provide a glossary to explain grants/contracts terms that may be unfamiliar.
8. Provide the scoring rubric so applicants understand how they will be scored.
9. If using an online application system, ensure that the number of available upload 

fields matches the number of documents required to be uploaded. This will 
support applicants in making a 1:1 correlation between what is required to submit, 
and what they are actually submitting. Naming these fields for uploading to match 
what should be uploaded would be additional assistance.

10. Include an evaluation component (external or via technical assistance) that 
grantees have to respond to at the end of their grant, so they have the opportunity 
to reflect on outcomes. This is harder than expected, especially with fledgling 
organizations.

11. A question in the proposal should address the specific outcomes that the RFA is 
intended to address (i.e., deliverables) – the more clear this is on the front end, the 
better the applications and outcomes on the back end.



Panel Review of Applications

1. As noted above, reviewers should reflect the population who are expected to 
submit applications. Self-advocates who have experience in the topic being funded 
should be included in the review panels and decision-making process.

2. A training call for reviewers must be mandatory. It should provide detail in multiple 
formats, such as conference calls, online meeting rooms for visual support, and 
closed captioning.

3. In the reviewer training, provide concrete examples of what to look for in the 
application when scoring each section.

4. Clearly define “conflict of interest” between reviewer and applicant, and ask 
probing questions of reviewers to ensure no conflict exists. 

5. Complete an initial review of applications to ensure all required information is 
present, and put aside incomplete applications. These do not need to go to the 
review panels, as they did not meet minimum requirements.

6. Provide adequate time for panelists to review and score the applications prior to 
full panel review. Be available to provide support top self-advocate reviewers if 
needed.

7. Full review panels should utilize multiple formats, including audio and visual with 
conference call and online meeting room.

8. Ensure inclusive facilitation of review panelists, so everyone is heard. Facilitators 
must be strong models for this, as some reviewers may need more time to speak.

9. Facilitators should summarize comments and scores on each part of each 
application to keep everyone focused and aware of progress. 

10. Walk cautiously where proposals rely heavily on information technology, as there 
are significant disparities in access to technology, accessibility of technology, and 
support and assistance needed to utilize technology

11. Provide adequate time for full panel review. Plan for follow-up time to 
accommodate scenarios where full review is not completed in planned time. It is 
far better to plan for a second meeting of the panel and not need it, than to need it 
without having it planned in advance.

12. An additional staff person should be present with the facilitator in every full review 
panel to take notes of reviewer comments. This frees the facilitator to manage the 
technology and conversation.

13. Review comments should be returned to applicants so they learn what went well 
and what could be improved in their grant writing.

14. Provide visual cues for scoring rubrics such as a Likert scale of points with happy 
faces on one side and sad faces on the other.

15. Provide prompting questions for each section of scoring rubric, to guide reviewers 
in what to look for when considering score.



16. If a tiebreaker is needed to identify the highest-scoring applications for funding,   
consider geographic location, cultural and linguistic diversity, and other 
demographics of applicants’ groups (for example, a youth self-advocacy group). 
Determine these criteria well in advance, and include it in the scoring rubric.

17. Conflicting recommendations were received regarding the scoring process: (a) 
Consider averaging scores of reviewers, rather than require panelists to agree on 
score, to avoid arguments on panel; and (b) Require panelists to agree on a score to 
encourage conversation and make the most of this learning opportunity regarding 
grant writing. Consider both options in advance, and clarify with reviewers.

Funding Awards

1. Carefully review contract template. Remove any requirements that are not 
absolutely necessary. Recognize that self-advocacy organizations may not be 
as developed as other groups who receive federal or foundation funds, and set 
contracting expectations accordingly (see Appendix A).

2. Provide a companion document to explain sections of the contract (see Appendix 
B)., as well as a glossary of terms. This will help self-advocacy organizations become 
familiar with the language used in grants and contracts.

3. Double-check scope of proposed work and budgets of highest-scoring applicants to be 
sure their efforts are within the guidelines of the RFA, and that no monies are allocated 
for costs that were restricted in the RFA. Communicate with grantees
 where necessary to revise budget accordingly.

Ongoing Grant Management

1. Keep grantees on task with the deadlines for invoices and reports by sending 
reminder emails a month out, then once a week out and finally the day before the 
due date.

2. Follow up with grantees personally after receipt of each report to review progress on 
their project and be available to provide technical assistance on any topic. 

3. If a grantee is not communicating effectively, be persistent until receiving a 
response from contact. When contact has been made, review the grantee’s 
responsibilities in maintaining communication regarding the award. Reach out to 
others for assistance if problems with communication persist; it is likely someone 
else knows another way to reach the grantee.



Language Accessibility

Several self-advocacy groups, including National Youth Leadership Network, Kids As 
Self Advocates, Green Mountain Self-Advocates, and others, have developed guidance 
for language accessibility. The recommendations below reflect their guidance.

Recommendations:

1. Use clear and direct language; avoid or explain conceptual words
2. If using a complicated (hard) word is necessary, explain what it means in the same 

sentence
3. Use examples to explain complex ideas and concepts
4. Use short sentences (generally fewer than 15 words)
5. Use one and two syllable words as much as possible
6. Use clear font like Arial or Verdana. Serif fonts have tiny details at the ends of some 

strokes of letters. This can cause letters to blur together and make them harder to 
distinguish

7. Use clear headings, left-aligned to separate short chunks of text. Headings help 
people find or keep their place in the document

8. Ensure that RFAs and grant applications instructions are provided in screen-reader 
friendly format

9. Provide a glossary to explain grants/contracts terms that may be unfamiliar 
10. Provide a companion document that explains the template language in cognitively 

accessible language if template language cannot be changed due to administrative 
rules
• The language used in the templates should be accessible to everyone. 

Providing a companion document may be at least one way of making them 
more accessible if there is no way to change the language required by the HHS 
administrative rules.

11. Use word processing software tools to check for accessibility 
• In Microsoft Word 2010, click on File > Check for issues > Check accessibility)

12. Use word processing software tools to check for readability 
• In Microsoft Word 2010, click on File > Proofing > ensure “Show readability 

statistics” is checked
• Then click Review > Spelling and Grammar > click through until “Readability 

Statistics” is displayed. Flesch-Kincaid Grade Level should be at 8 or below
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APPENDIX A 

 
SAMPLE SUBCONTRACT AGREEMENT 

 
  



[Funder Organization Name] 
 

CONTRACT AGREEMENT 
[Grantee Organization Name] 

 
This Contract is by and between [Grantee Organization Name] (hereinafter called the “Subcontractor”) 
and the [Funder Organization Name] (hereinafter called “Name”). 
 
 

WITNESSETH THAT: 
 
Whereas [Name] is conducting initiatives under a contract from the [Name of federal, foundation, or 
other funder if appropriate]; and 
 
Whereas the Subcontractor desires to enter in an agreement with [Name] to carryout activities to 
strengthen self-advocacy and collaborate with [Name]; 
 
Now therefore in consideration of the mutual covenants and premises contained herein, the parties 
hereto agree as follows: 
 
 
ARTICLE 1.  STATEMENT OF WORK 
 
Many self-advocacy groups do not have formal registration as a non-profit organization, and might have 
very informal structure in place. [Name] is partnering with self-advocacy organizations that want to 
move to the next step to strengthen their organization and become a non-profit. Just like any nonprofit, 
self-advocacy groups need to grow their structure and capacity and work within federal, state and local 
requirements so that they can apply for grants, manage grant money, and continue as a strong 
organization.  
 
The Subcontractor agrees to undertake capacity building activities in accordance with the Statement of 
Work as described within proposal ID #xx and as submitted to [Name], and which is incorporated by 
reference into this Agreement.  
 
          
ARTICLE 2.  DELIVERY OF PERFORMANCE SCHEDULE  
 
The Subcontractor shall furnish and deliver the services/products required by Article 1, in accordance 
with the following schedule: 
 
All work specified in Article 1 is to be completed by the December 31, 2013 unless otherwise noted in 
Article 1. The period of performance under this contract is specified as January 1, 2013 through 
December 31, 2013 for which period funds are available and allotted.  
 
ARTICLE 3.  ALLOWABLE COSTS AND PAYMENT 
 

1) The cost of performance of this contract is based upon a fixed fee basis. Total project cost is 
$5,000. Costs shall be incurred in accordance with the Budget as described within proposal ID 
#xx and as submitted to [Name], and which is incorporated by reference into this Agreement.  



 
2) Payment for performance under this Agreement shall be made by [Name] to the Subcontractor 

on a fixed fee basis of $5,000 allocated in 3 reimbursements. The allocations shall be dispersed 
upon receipt of invoices on the following schedule. In no event shall the final invoice be 
submitted to [Name] no  later than the end of the contract termination date.   

 
 
 
 
 

 
Payments for performance under this Agreement shall be issued by [Name]  to the 
Subcontractor within 45 days of receipt of proper, approved invoice(s).  Proper, approved 
invoices shall contain:  

 
a. The invoice date. 
b. Sufficiently itemized expenses/activities for which the Subcontractor is 

invoicing. 
c. An original dated approval signature of an authorized representative of the 

Subcontractor.  This signature shall certify that the expenses/activities 
recited in the invoice are consistent with the terms of this Agreement.  

 
A sample blank invoice is appended as ATTACHMENT A and is an integral part of this 
Agreement. 

 
3) Invoices referencing [title of project] should be sent to the attention of [CONTACT PERSON], 

either in hard copy or electronically, but not both.  The Subcontractor may submit the invoice 
electronically via email to [CONTACT E-MAIL] or in hard copy to: 

 
[Name] 
[Address] 
Attn: [CONTACT PERSON] 
 

4) Invoices that exceed either the period of performance of this Agreement or the obligated 
amount of this Agreement may be considered improper invoices and may be returned to the 
Subcontractor unpaid.   
 
 

ARTICLE 4.  EVALUATION OF PERFORMANCE 
 
The Subcontractor shall submit programmatic reports to [Name] to track the Subcontractor’s level of 
progress on the proposed objectives and activities of the project.  Progress reports will be submitted 
updating project progress as described below.   
 

 
 
 
 
 

Invoice No. Invoice Period Due Date 
First January 1 – April 30 May 31, 2013 
Second May 1 – August 31 September 30, 2013 
Third September 1 – December 31 January 1, 2014 

Quarter Period Report Due to [Name] 
1 January 1 – March 31 April 30 
2 April 1 – September 30 October 30 
3 (Final) October 1 – December 31 January 30 



 
A total of 3 programmatic progress reports will be submitted to [Name], either in hard copy or 
electronically, but not both.  The Subcontractor may submit the progress reports electronically via email 
to [email address] or in hard copy to: 

 
[Name]  
[Address] 
Attn: [Contact Person]  
 

A sample blank progress report is appended as ATTACHMENT B and is an integral part of this 
Agreement. 

 
ARTICLE 5.  INDEPENDENT SUBCONTRACTOR STATUS 
 
In performing activities under this Agreement, the Subcontractor shall be deemed to be and shall be an 
independent subcontractor and, as such, shall not be entitled to any benefits applicable to employees of 
[Name]. 
 
ARTICLE 6.   ASSIGNMENT 
 
The Subcontractor shall not assign the agreement, in whole or in part, without first obtaining the written 
consent of [Name].  
 
 
ARTICLE 7.   RECOGNITION 
 
[Name] agrees to give appropriate professional recognition to any work performed by the Subcontractor 
to perform tasks covered by this contract.  
 
ARTICLE 8.   LIABILITY 
 
The Subcontractor is solely and exclusively liable to third parties for all expenses incurred by the 
Subcontractor, for all claims of damages arising out of performance by the Subcontractor under this 
agreement, and for the payment of all required Federal, State, and local taxes and contributions.  The 
Subcontractor warrants that no part of the amount paid under this agreement shall be paid directly to 
any officer or employee of the U.S. Government. 
 
ARTICLE 9.   INDEMNIFICATION 
 

A. Each party shall be responsible for its negligent acts or omissions and the negligent acts or 
omissions of its employees, officers, or directors, to the extent allowed by law. Neither party 
assumes any responsibility to the other party for the consequences of any act or omission of any 
person, firm or corporation not a party to this Agreement. 

 
ARTICLE 10.   DISPUTES 
 
There is no formal procedure established for resolving disputes between [Name]  and the 
Subcontractor.  It is [Name]’s policy to make every reasonable effort to resolve all issues fairly by 



negotiation without litigation.  Any disputes arising under this Agreement shall be brought to the 
attention of [Name]  and pursued through the appropriate court of jurisdiction.   
 
This Article shall not be construed to limit the administrative or legal rights otherwise available to the 
parties in the event of violations of the terms or conditions of this Agreement. 
 
ARTICLE 11.   RECORDS AND AUDIT 
 
The books of account, files and other records of the Subcontractor and Partner which are applicable to 
this contract shall be available for inspection during the period of the subcontract and for one year after, 
review and audit to determine the proper application and use of all funds paid to or for the account or 
benefit of Subcontractor. 
 
ARTICLE 12.  GOVERNING LAW 
 
Unless otherwise provided by a specific term of this Agreement, this Agreement shall be governed by 
and interpreted in accordance with the relevant [Name of federal, foundation, or other funder, if 
appropriate]. 
 
ARTICLE 13. TERMINATION 
 
Either party may terminate or suspend this Agreement in whole or part upon written notice to the other 
party, with a minimum of 30 days notice. 
 
ARTICLE 14. ENTIRE AGREEMENT 
 
This writing contains the entire agreement of the parties and there are no promises, understandings, or 
agreements of any kind pertaining to this Agreement other than those written in this Agreement. 
 
ARTICLE 15.   ACCEPTANCE 
 
This Agreement shall not be considered accepted or effective until signed below by authorized 
representatives of both of the parties.  By signing below, each individual certifies that he or she is 
authorized to bind his or her organization to this Agreement. 
 
IN WITNESS WHEREOF, the parties hereto have executed this contract as of the day and year first above 
written: 
 
 
_______________________________________    ____________________ 
[GRANTEE ORGANIZATION SIGNATURE]      DATE    
 
_______________________________________ 
EIN No. if applicable  
 
 
______________________________________    ____________________ 
[NAME ORGANIZATION SIGNATURE]     DATE 

 



 
       

ATTACHMENT A: SAMPLE INVOICE TEMPLATE

 
Project:   [Name of project] 
 
Subcontractor:  [Fill in Name of Organization] 
 
Invoice Date:                   [Fill in date you submit this invoice] 
 
Period of Performance:   [Fill in the period covered in this invoice] 
 
Submitted to:  [Funding organization name] 
         [Address] 
         Attn: [CONTACT PERSON] 
 
Check Payable to:  [Fill in who the check should be made payable]  
  [Fill in the address where the check should be sent] 
    
The following services were provided/will be provided during this invoice period:  
 [list from your scope of work services that were provided/will be provided during the invoice period]  

 
Total Reimbursement Request for the Period: [Fill in total to be reimbursed for the period] 
 
Itemized Expenses: [Detail expenses to be reimbursed for the period] 
 
Signature of authorized certifying official: 
 
______________________________ ____________________________ 
[Typed or Printed Name]    Date 



ATTACHMENT B: SAMPLE PROGRESS REPORT 
 
 
 
Project:    [Fill in name of project] 
 
Subcontractor:   [Fill in Name of Organization] 
 
Report Date:    [Fill in date you are submitting this repot] 
Period Covered by Report:  [Fill in reporting period] 
 
PART 1:  
 
Report on progress on all activities as outlined in the Work Plan submitted with your proposal.  Format:  
insert Goals and Objectives table, report on status of each activity. 
Example: 
GOAL 1: State Goal 
Activity 1: (list activity) Not Started In 

process 
Completed Date 

Completed 
     
     
     
Notes: 
 
 
PART 2: Provide narrative in each of the following areas to indicate activities and current status for this 
quarter. 
 
Key Accomplishments 
 
 
Problems/Barriers Encountered 
 
 
Changes to scope of work 
 
 
Staffing/budget changes 
 
 
Attachments (if any) 
 

 



APPENDIX B 

 
SAMPLE SUBCONTRACT AGREEMENT COMPANION DOCUMENT 

  



EXAMPLE: Subcontract Agreement - Companion Document 
 
This contract is between your organization and [Grantee Organization Name] [(Name)]. In the contract, 
you are called the “subcontractor.” Whenever you see the word “subcontractor,” this means your 
organization.  
 
Witnesseth that: 
Your funds will be awarded come from the [Federal, foundation, or other funder, if appropriate]. [Name] 
will help to manage and coordinate the mini-grants through a contract with [Federal, foundation, or 
other funder, if appropriate].  
 
Article 1:  Statement of Work 
Your organization agrees to do the work that you stated in the proposal that you wrote. Your proposal is 
now part of the formal contract documents. 
 
Article 2:  Delivery of Performance Schedule (Timeline) 
Your organization will accomplish the activities within the timeline that was stated in the proposal. 
All of your proposed work needs to be done by December 31, 2013. Your contract and funding is from 
January 1, 2013 – December 31, 2013. 
 
Article 3:  Allowable Costs and Payments 

1- Your contract is based on a set fee. The total funding is $5,000.00.  The money you spend should 
follow the budget that you submitted in your proposal.  

2- Your organization will be reimbursed by [Name] of a fixed amount of $5,000 in three payments. 
The schedule of the payments is listed in your contact in Article 4: Allowable Costs and 
Payments. Payments will not be sent until [Name] receives an invoice from your organization. 
Your last invoice needs to be received by [Name] no later than December 31, 2013. The invoices 
must include the following, or they cannot be paid:  

a. Invoice Date 
b. Itemized expenses/activities for which your organization is invoicing. This is a list of 

what you spent the money on.  
c. You invoice must have a date and signature in order to be processed. Your signature on 

the invoice states that the expenses and activities that you listed are the same as what 
you agreed upon in your proposal. 

3- A sample invoice is Attachment A of the contract, and you can use this as a template for your 
invoices. Invoices need to be sent to [Contact person] either by email or mail but not both. The 
email and postal mail addresses are in the contract.  

4- Invoices that are dated past your timeline will not be reimbursed and may be returned to you 
unpaid. 

 
Article 4:  Evaluation of Performance 
You will give 3 reports in writing, 1) how things in your project are going, 2) if you are meeting your 
timelines, 3) what’s working well and what’s not working? We also need to know any changes to the 
budget that your organization thinks are needed. The schedule of the progress reports payments is 
listed in your contact in Article 5: Evaluation of Performance. A total of 3 reports need to be sent to 
[Name]  either in hard copy or electronically, but not both. The email and postal mail addresses are in 
the contract. A blank report is Attachment B of the contract, and you must use this as a template for 
your reports. 
 



Article 5:  Independent Subcontractor Status 
You are not an employee of [Name]  and you will not receive employee benefits. 
 
Article 6: Assignment 
You may not give this work to another organization to complete, without [Name]’s permission to do so. 
 
Article 7:  Recognition 
[Name]  will not take credit for the work your organization completes under the contract, but will 
recognize your organization for the work it does on this contract. 
 
Article 8:  Liability  
Your organization is responsible for any or all expenses that you used during the projects. Your 
organization is responsible for any reports of damages from activities that were caused from your 
project. Money used from this contract cannot be used to pay any employee of the US Government. 
 
Article 9:  Indemnification 
[Name] is not responsible for any of your wrong doings. You are not responsible for any of [Name]’s 
wrong doings. 
 
Article 10:  Disputes 
[Name]  will try to resolve any arguments that your organization has with them. There is no formal 
policy written to address how to resolve disagreements. If any arguments do happen and we can’t solve 
it, then they will be brought to the proper authorities. Your rights to settle disagreements are not 
limited. 
 
Article 11:  Records and Audit 
Your organization’s files, records and accounts should be available for inspection or review during the 
contract and up to one year after. Your contract will follow the appropriate rules about receiving federal 
funds.  
 
Article 12:  Governing Law 
This contract will follow the rules of [federal, foundation, or other funder, if appropriate]. 
 
Article 13  Termination 
If you would like to stop this contract you have to give [Name]  30 days written notice. If [Name]  stops 
the contract, [Name]  needs to give you 30 days written notice. 
 
Article 14:  Entire Agreement 
This contract, attachments, and your proposal as referenced in the contract is the written form of your 
agreement with [Name]. Anything not written in, attached to, or referenced by this contract (like your 
proposal is referenced) is not part of the contract. 
 
Article 15:  Acceptance 
This contract will not be official until [Name]  and the person who is responsible for the grant in your 
organization and your partner organization signs and dates the contract with your tax number.  




